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1. GETTING STARTED

This User Manual will help you to familiarize yourself with the Friday Stableford application. The dialog
boxes and controls in this User Manual may appear different from the dialog boxes and controls that
appear on your computer screen.

1.1 What is Friday Stableford?

Friday Stableford is a nine-hole, gross quota, team competition with a minimum of three and a maximum
of four players per team. Friday Stableford is played at the Deep River Golf Club every Friday from dawn
to dusk, weather permitting. Players can play as many 9-hole rounds as they like, with whomever they
like, if tee times are available. The entry fee is $2.00 for each player for each 9-hole round and the prize
money is distributed 50% for first place, 30% for second, and 20% for third, based on a plus/minus points
system. If the total amount collected is below a certain amount, the prize money is distributed 60% for
first place and 40% for second. The application allows the entry fee to be changed. Points are awarded
in relation to par at each hole.

The application calculates and prints the points needed by each player every week. Points are originally
calculated based on the player’s current handicap factor, until the player has played at least five 9-hole
rounds. After a player signs up the team, a scorecard can be printed, displaying each player and their
points needed and the team total points needed. The scorecard also displays the currently selected
points in relation to par.

After all the 9-hole rounds are posted into the system, the application allows the users to print the team
scores hole-by-hole in the team’s plus/minus points order, from the highest to the lowest plus/minus
points. The application also calculates the money distribution and prints the final results to the default
printer.

The Friday Stableford application is designed to allow players to:

e Sign up their team of 3 or 4.

*  Print their team’s scorecards.

* Modify team players.

* Remove their team from a round that they signed up for and they did not start the round.
* Add and edit their team’s scores.

This User Manual describes all the steps necessary to complete a Friday Stableford event.

Please take a moment to familiarize yourself with the text conventions, terms, and controls used in this
User Manual.

1.2 Text Conventions

The examples below explain the specially formatted text used in this User Manual.

» Dialog boxes and control names appear in bold type: Select Member dialog

» Keyboard key names appear in bold type: Home, End, Backspace , Tab

» Keyboard keys that must be pressed at the same time to perform a task appear in bold type with
a plus (+) between the key names: Alt+H

» Drives appear as capital letters: drive C

» File names appear in italics with an initial capital letter: Setup.exe

» Command line statements appear in lower case bold type: a:\install

« Names of icons appear in bold type: My Computer icon

* Menu items, option buttons, and check boxes appear in bold type: Programs , Accessories
Tournament option, Use 18-Hole Factor check box
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1.3 Terms

You can use either a single-button mouse or a multiple-button mouse with this application.

If you have a multiple-button mouse, the left mouse button is the primary mouse button, unless you have
configured it differently. Any procedure that requires you to click the secondary button will refer to it as
“the right mouse button.”

If you have a single-button mouse, pressing the Ctrl key while clicking the mouse button is the same as
clicking the right mouse button.

This User Manual uses the following terms.

Term Meaning

Friday Stableford Name of application.

Press Strike a key from the keyboard.

Type Strike a key from the keyboard to display text

on the screen. Do not press the Enter key
after entry is complete, unless instructed to do

So.
Enter Type the entry, then press the Enter key.
Point Position the mouse pointer until the tip of the

pointer rest on whatever you want to point to
on the screen.

Click Point, press and immediately release the left
mouse button without moving the mouse.

Double-click Point, press and immediately release the
mouse button twice without moving the mouse.

Drag Point and then hold down the mouse button as
you move the mouse.

Choose Click a command button. Click an item from a
menu bar or dropdown menu.

Select Click a command button. Click an item from a

menu bar or dropdown menu. Click an option
button to make a black dot appear. Click a
check box to make an X appear. Click and
item in a list box, then click OK, or double click
and item in a list.

Clear Click an option button to make the black dot
disappear. Click a check box to make the X
disappear.

In Windows, the terms choose and select have different and specific meanings. Selecting an item usually
means mark it with the selection cursor, which can appear as a highlight, a dotted rectangle, or both. You
also select check boxes and option buttons in dialogs. Selecting alone does not initiate an action.

You choose an item to carry out an action. For example, choosing a command button or menu item
might open a dialog or carry out a command. You often need to select an item before you can choose it.

1.4 Controls

You can use a combination of mouse and keyboard techniques. For example, you could click an item to
select it, and then press Enter from the keyboard to choose it. When a procedure in this User Manual
says to choose an item, generally you can use whichever method you prefer.
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This section gives basic information about controls and their functions. Throughout this Guide, the control
name will be in bold type. For example, select OK or select Courses Table check box. The controls
found in the 9-Hole Stroke Play application are similar as shown below.

Button (114 Tulerm Par |E5it Add Edit Delete Setup

Text Box | | Frame { Lomgeziz
Cotrho Box | Hole-By-Hole j| |
L ]
Icon lw
Option Button ® Eirst Name [John Smith)

Checlk: Bozx ¥ Couwrses Table List Box Oranges

Bananas
Spin Control |15 [4] | Pears
1.4.1 Button or Command Button

You choose a command button to initiate an action, such as carrying out or cancelling a command.
Common command buttons are OK and Cancel. They are often located along the bottom or on the right
side of the dialog.

A command button, followed by an ellipsis (...) or a double greater-than sign (>>) opens another dialog
box.

Unavailable command buttons are dimmed. The currently selected button has a darker border than other
buttons. You can choose the currently selected button, simply by pressing the Enter key.

To choose a command button, click the command button. Or press the Tab key until the button you want
is selected, and then press the Enter key.

1.4.2 Text Box

You type information into a text box. When you move to an empty text box, an insertion point (a flashing
vertical bar) appears. The text you type starts at the insertion point.

If the box you move to already contains text, and the text is highlighted, any text you type replaces it. You
can also delete the existing text by pressing the Delete key or Backspace key.

To select text in a text box, drag the pointer across the text, or double-click a word to select one word at a
time. Or press and hold down the Shift key while pressing an Arrow key.

1.4.3 Combo Box

A combo box appears initially as a rectangular box containing the current selection. When you select the
down arrow in the square box at the right, a list of available choices appears. If there are more items than
can fit in the box, scroll bars are provided.

To open a combo box and select an item:
1. Click the arrow at the right to see a list of available choices.

2. Click the up or down scroll arrow, if visible or drag the scroll box to move to the item you want to
select.

3. Click the item.

144 Option Button

Option buttons represent a group of mutually exclusive options. You can select only one option at a time.
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If you already have one option selected, your current selection replaces it. The option buttons are,
generally enclosed in a frame. The selected option button contains a black dot. Names of unavailable
options are dimmed.

To select an option button, click the option button.

1.4.5 Check Box

A check box means you can select or clear an option. You can select as many check-box options as
needed. When a check box is selected, it contains an X. Names of unavailable options are dimmed.

To select or clear check boxes, click the check box.

1.4.6 Spin Control

The spin control is a control that works with another control, such as a text box to increment and
decrement values. It can also, scroll back and forth through a range of values or a list of items.

To continue to increment the value, click the up (or right) arrow of the spin control and hold down the
mouse button, then release the mouse button when the desired value is displayed. Likewise, repeat the
latter by clicking the down (or left) arrow to decrement the value. If a flashing vertical bar appears when
you drag the mouse cursor over the area left of the up (or right) and down (or left) arrows, the control
contains a text box. If the area is highlighted or selected you can change the value or list with the up and
down (or left and right) arrow keys from the keyboard.

1.4.7 Menu Bar

The menu bar contains a list of menu items. Some commands carry out an action immediately; others
display a dialog so that you can select options, or a dropdown menu. Dimmed menu items are
unavailable.

A menu item followed by an ellipsis (...) opens another dialog.

1.4.8 Frame

A frame groups the controls together. The name of the frame usually describes the group of controls.

1.4.9 Icon

Icons are small pictures that represent something. For example, the icon in the previous illustration
represents a male. Some icons act as a command button.

1.4.10 List Box

A list box displays a list of choices. If there are more choices than can fit in the box, scroll bars are
provided so you can move quickly through the list. Some list boxes are accompanied with a text box. If
you type a letter in the text box the list box scrolls to match the letter you type.

Usually, you can select only one item in a list box. There are some cases when you can select more than
one item.
To select a single item from a list box:
» Use the method as described above or
»  Click the scroll arrows until the item you want to select appears in the list
» Click the item, and then choose the appropriate command button or double-click the item to
select it and complete the command all in one step.

To select multiple sequential items in a list, click the first item you want to select, and then drag the cursor
to the last item you want to select.
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To cancel the selection, click any item in the list or click the first item you want to select, press and hold
down the Shift key, and click the last item you want to select. Both items, and all items in between, are
selected.

To select multiple non-sequential items in a list, press and hold down the Ctrl key, and click each item
you want to select.

To cancel a selection, press and hold down the Ctrl key, and click the item again.

15 System Requirements

The application will operate on the following operating systems and configurations:

* PC with a 266 MHz or greater Pentium-class processor

e Microsoft Windows 95/98/2000/ME/XP/Vista

* 256 MB of RAM or greater

e 15 MB available hard drive space

e CD drive

*  Monitor supporting 800 x 600 or greater resolution with at least 256 colors

Set DPI Setting to 96 DPI



GO]fSO ™ Page 2-1
S Software

2.

INSTALLATION AND SETUP

The application must be installed to a hard disk, before it can run. Please look at the appropriate
instructions below.

2.1

Installing from Website

To install application from Golfsoft Software website:

ouhrwNE

2.2

Logon to the Golfsoft Software website (www.golfsoftsoftware.ca).

Click the Friday Stableford hyperlink.

Click the Download Application hyperlink and save to your desktop.
When the download is complete and successful, logoff from the website.
Double-click the Stroke9Setup icon from your desktop.

Delete the Stroke9Setup icon from your desktop.

Installing from CD-ROM

To install application from CD-ROM:

1.
2.
3.

2.3

Turn on your computer and start Microsoft Windows 95/98/2000/ME/XP/Vista.

Place the application CD in your CD-ROM drive.

If AutoPlay is enabled, the installation will begin once the drive closes, follow the on-screen
instructions.

Or

If Auto Play is not enabled, you will need to manually install the application. Double-click the My
Computer icon on your desktop, double-click the icon for your CD-ROM drive, and then double-
click the Stroke9Setup.exe icon. Once the installation begins follow the on-screen instructions.

Uninstalling Application

To uninstall application:

1
2.
3.

Turn on your computer and start Microsoft Windows 95/98/NT4/2000/ME/XP/Vista.

Click the Start button on the taskbar, point to Settings , and then click Control Panel .
Double-click Add or Remove Programs , select Golfsoft Software Friday Stableford , and then
click Add/Remove to uninstall the application.
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3. GETTING STARTED

3.1 Starting Application

To start Friday Stableford application from the Start Menu , click the Start button on the task bar, point
to Programs , then Golfsoft Software , and then select Friday Stableford to launch the application.

To start Friday Stableford application from the Handicap Manager 2011 , click the Friday Stableford
button.

To start Friday Stableford application from the desktop , double-click the Friday Stableford application
icon on your desktop.

3.2 Start Up

Once the application is started, a Start Up window will appear.

startup X

System Manager Access

Signup Team

Remove Team

Add Team Scores

|
|
| Modify Team
|
|
|

Edit Team Scores

Fridav Stableford Esc Key
- to Cancel
Click any buttan.
3.21 System Manager Access

Click the System Manager Access button to obtain access to the main Friday Stableford application. If
the application is password protected, type in the System Manager password and click the OK button.

3.2.2 Cancel

Click the Cancel button or press the Esc key from the keyboard to exit the Start Up window.
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3.2.3 Signup Team

This command button allows a player of the team to:

e Sign up their team of 3 or 4 players (front nine, back nine or both).
*  Print their team’s scorecards.

To sign up a team, click the Signup Team button and enter a valid access code. This action will open
the Sign Up Team dialog.

Sign Up Team ﬂ

add  Clear
Front Nine (White) Gross Score | 1 :
Hole 1 2 /3 4 5 6 7 8 9 Ou Points
Par 5 4 4 3 4 4 3 4 5 36 M| N |+
Back Nine (Yellow) Gross Score | 2 :
Hole 10 11 12 13 14 15 16 17 18 In Points
Par 5 4 4 3 4 4 3 4 5 36 M| N |+

Copy

Scorer:

Francis Mattie

Add to Scorecard Cancel Print

Feady ...

Note: The access code that is used to sign up the team is required to:
¢  Modify team.
* Remove the team from the competition.
* Add team’s score.
« Editteam’s score.
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3.2.3.1 Add
The Add menu item offers commands to 4 dropdown menus:
Add

3 Players ko Fronk Mine. .,
4 Players ko Fronk Mine. .,
3 Plavers ko Back Mine. ..
4 Playvers ko Back Mine. ..

To sign up a team:

1. Click Add from the menu bar and the appropriate dropdown menu item.

2. Select each player from the Select Golfer dialog.

As you select each player, the player’s quota (points needed) will be displayed in the appropriate
row in the N column.

3. If you selected a front nine team and the same team is playing the back nine, click Copy button.
You can also add or change a player by selecting the appropriate button on the left side of the
scorecard.

4. Click the Add to Scorecard button to save the current team players to the system scorecard.

x

& | Vour team was successfully added to the Friday Stableford scorecard.

-

Do wou want to print the scorecard?

5. If the team was successfully added to the Friday Stableford scorecard, click the Yes button to
print scorecard(s) (See sample in Section 7.1).

3.2.3.2 Clear

The Clear menu item offers commands to 2 dropdown menus:

Clear

Front Mine
Back Mine

To clear the front nine, click Clear|Front Nine from the menu bar.
To clear the back nine, click Clear|Back Nine from the menu bar.
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3.24 Modify Team

This command button allows the player that signed up the team to modify the team. If a player was
signed up and did not show, the player can be removed from the team to make a 3-man team or the

player can be substituted with another player.
To remove a player:
1. Click the Modify Team button.
2. Enter the access code that was used to sign up the team and click the OK button.

Scorer: E
Francis Mattie Key
to Cancel
Team What team do you want to modify?
1 | Franciz b attie, Tam Lomie, John Alessio, Rick Roussele I Fratt Mine

3. Click the button containing the team to modify.

Change Players [

Sigrup Mumber: |1
T otal Points Needsd: | 39

Meed
Plaper 1: | Mattie. Francis D IT
Player 2: | Lornie, Tom D IT
Player 3 | Alessio, John  [_| |10
Player 4: | Rousselle, Rick D IT

| (1] 4 || Cancel I

4. Toremove player, click the appropriate Delete button.

5. To substitute a player, click the appropriate button to the right of the player to be substituted.
Select another player from the list and click the OK button.

6. Click the OK button to accept changes.
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3.25 Remove Team

This command button allows the player that signed up the team to remove the entire team from the
competition. This may be necessary, if the team did not start the 9-hole round for some unforeseen
reason.
To remove the team from the 9-hole round:

1. Click the Remove Team button.

2. Enter the access code that was used to sign up the team and click the OK button.

Scorer: E
Framcis Mattie Key
to Cancel
Team What team do you want to remove?
1 | Frahciz Mattie, Tom Lormie, John &lessio, Rick Rouszele I Frant Mine

3. Click the button containing the team you want to remove.
4. Click the Yes button from the Confirm... window.

3.2.6 Add Team Scores

This command button allows the player that signed up the team to add scores for each player on the

team.
To add team score for each player:
1. Click the Add Team Scores button.
2. Enter the access code that was used to sign up the team and click the OK button.

Scorer:
Francis Mattie e LI
to Cancel

Team What team do you want to add scores for?
1 | Frahciz Mattie, Tom Lormie, John &lessio, Rick Rouszele I Frant Mine

3. Click the button containing the team you want to add scores.
|| Movember 22, 2008 | Sighup Murmnber: ,1_

[ Deep River Golf Club

Hale Mumber ||1 3 R ] |9||Tot||1El 1 (121214 [15]16|17 18|| In ||Tot|
Yardage [536(293( 433|155 371 |[389] 216/ 362525 3280451 [354] 361 [185(310]423][ 47 421 475|167 | 5447
Par 0 N N =T < O o e = (T3
Handicap 1138 1719 7 [15(11[ 3 208 12]1614(10]18 4 [ &
[ Hame 1234|5678 9|Tot|1|[2|3|4|5|6]7 8 9|MI|HNI Pt
Franciz Mattie 10 Fa
Tom Lornie 14 1
John Slessio 10
Rick Rouszelle 5 39
All Above
Scorer: Ezc Key
. . i : oK
Francis Mattie Total Points Needed: | 39 to Cancel

| Ready ...

4. Click the All Above button.
Click the button containing the player’s name to add one player at a time.

5. Enter each player’s hole-by-hole score when prompted to do so.
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Team #1 - Francis Mattie |
|| Deep River Golf Club ||| Saturday, Hovember 22, 2008 |
Hole Mumber 1 2 3 4 5 E 7 g 9 Tot
‘Y ardage 536 || 293 || 433 [/ 155 |[371 || 389 [ 216 || 362 | 525 || 3280 | Front Nine
Par 5 4 4 3 4 4 3 4 5 36
Score 5 4 4 4 5| 5 5| 4 4 40 [Meed || Prs
Paints 2 2 2 1 1 1 0 2 3 14 10 +4
= L)
Secore must be > 0and <=19 lw E Key
to Cancel

| Prezs the EMTER key to add score. |

6. Click the Enter button.
7. After all the scores have been added, click the OK button to post scores.

3.2.7 Edit Team Scores

This command button allows the player that signed up the team to edit each player’s scores on the team.
To edit player’s score:

1. Click the Edit Team Scores button.

2. Enter the access code that was used to sign up the team and click the OK button.

Scorer: E
Francis Mattie Rey
to Cancel
Team What team do you want to edit scores for?
23 | Franciz Mattie, Tim Hartwig, Rick Rousselle, Lindzay Meilleur Front Mine
24 | Francis Mattie, Tim Hartwig. Rick Rousselle Back Mine
3. Click the button containing the team and player you want to edit score.
| Deep River Golf Club [ June 13, 2008 | Signup Number: | 23
Hale Murnber 12340867839 Tot]10[11 121314151617 18] In | Tot
‘Yardage B36(293(14.33][155|[371|389] 216 362||525] 3280] 491 354|361 185310 423|1 47(|421 |4 75| 3167 | 6447
Par Slafapfajf4jaia)4is53E]54[42)44)3[4]5]3E]7
Handicap 13308 17197 (1511 3 28 |12 16| 14/10)18( 4 | B
[ Mame 1(2 (345|678 |9|Tot)1 2|34 |5|6|7(8(9[M]|N|Pts
Franciz M attie 000 0 =T (000 =<0 | = = e B
Tim Harbwig 30 =T =T = = P33 ) | P2 [ [ES e
Rick Raussels Eld4 |54l 6l7[5 (8|7 49 1211 /0ojofjof1(oje]a]-2
Lindzay Meilsur 65 65 |4 4|5 |57 47 |1 1o o2z ooz 7 [ ol-=3
[ anabove
Scorer: E=zc Key
q o i : oK
Francis Mattie Total Paints Needed: | 33 to Cancel
| Ready ..

4. Click the button containing the player’'s name and edit player’s score.
5. Click the OK button to accept changes.
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4. MENU ITEMS

File Course,.., Members.., MNon-Members,.. Players.., SignUp... Scares... fip Unéip Help

The menu bar contains a list of menu items. Some commands carry out an action immediately; others
display a dialog so that you can select options, or a dropdown menu. Dimmed menu items are
unavailable.

A menu item followed by an ellipsis (...) opens another dialog.

To access any of the menu items, click the item or press the Alt key from the keyboard and at the same
time press the underscored letter of the menu item. Some of the menu items have dropdown menu
items.

4.1 File

The File menu item offers commands to 6 dropdown menus:

| File
Mew, .,
Open...
Close
Delete. ..

Mew Season...

Prinkt Setup. ..

Exit

41.1 New

To create a new event, click File|[New... from the menu bar, which opens a New Event dialog. This
menu item will be disabled, if the default parameters have not been set (See Section 4.1.5). Set or select
the available options, as required. Click the Add button when finished.

Newevent X

MHame of Event: Friday Stableford Week #22 I 22

Mame of Club: |Deer Ridge Golf Club ™ Active

Drate: | Wednezday, Hovember 26, 2008 [ Members Only
Entry Fee

Fee: | $2.00 Total Collected:)  $0.00

F'.a_|,|;| Brown Box

Add Cancel

Ready ..

Name of Event — This text box allows the user to enter the name of the event or competition. The
application will automatically place a default name in the text box.

Members Only — This check box determines if non-members can play in the competition.
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Date — This is the date of the event. Click the Calendar button, to select the date.

ﬂ March 2008 ﬂ

S5u Mo Tuwe Th Fr 5a

1
2 3 456 7 8
9 10 11 [12]13 14 15
16 17 18 19 20 21 22
23 24 25 26 27 28 29
30 H

March 12, 2008
Press Enter Kep to Accept or
double click selection box.

Prezs Ezc Key to Cancel

Entry Fee

» Fee — This text box allows users to enter the entry fee for each 9-hole round by each player in the
competition.

» Pay — This text box allows users to enter the collector of the entry fee for the competition or
where to pay the entry fee.

» Total Collected - This box displays the amount of money collected for the competition.

4.1.2 Open

To open an old event:
1. Click File|Open... from the menu bar.
2. Select the event from the list.
3. Click the Open button.
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ﬁFriday Stableford - c:'.golfsoft’ friday

[ Friday Stableford Wosk #11 ® [ar
[ Deep River Gok Club (1972) Inc.
r
Hole Number [ 1 [2 (3[4 [5[6 788 /[0wf0f[12]13]14]15[16 17 (18] In | Tot
| Vardage {536 293 433155371 |38 216 [362 525 3280 [ 451 354 | 361 [[185 (310 [423[1147 421 475 3167 6447
| P [574f43[a4faf3[45[a[65[4[4a[3][4]4]3 4/5]36][7
[ Handicap [ 1 [13 75 J17[8 (7 [ws[rfa] f2fafr2fef1aftofreiafe] [ |

41.3 Close

To close an opened event and return to the main screen, click File|Close from the menu bar.

414 Delete

To delete an old event:
1. Click File|Delete... from the menu bar.
2. Select the event from the list.
3. Click the Delete button.
4. Click the Yes button on the Confirm... window.

4.1.5 New Season

To select default settings for the weekly Friday Stableford competition, click File|New Season from the
menu bar, which will open the defaults Parameters dialog. This function is generally used at the
beginning of the new golf season.
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Default Parameters

| Select Default Course. ..

| Set Previous Last Five Hounds. __

" Stableford Parameters:
Gross Points

Double Eagle:l 5
Eagle:l 4

Type of Bound: — |
1 Frant Mine Dnly
1 Back Mine Only

Page 4-4

]
(1] 4
Cancel

®:Front and B ack

Birdie:| 3

X Adults [3ender 1
F"Elfil 2 Minimum Meeded | [ Seniors ® ﬁ C *
BDEIE_'r'Zl 1 I 1] [ Juniors

Ciouble Bogey: | 0

Triple Boges: | 0

b axirium Meeded

@ Memberz Only
I 15

Front Back
| 1 |Deep River Golf Club | O Adin Fee: | 0% =
Fee: $2.00 TPayout1: | [Payout |
S |Bruwn Box Total Pat »= | $60.00 Tatal Pat < |$E|].|]|]
First: |5|]Z j First: IEI]Z ﬁ
Second: IBDZ j Second: I-lll]Z ﬁ
Third: |20z -
Ready ...

Select Default Course — Click this command button to set the default course. One of the Type of
Round options and one of the Gender options must be selected, before this button is enabled.

Set Previous Last Five Rounds — Click this command button to reset new season.
Type of Round - Select one of three options.

Adults — Select this check box, if adults can play in the competition.

Seniors — Select this check box, if seniors can play in the competition.

Juniors — Select this check box, if juniors can play in the competition.

Gender — Select one of two options.

Members Only — Select this check box, if non-members cannot play in the competition.
Fee — This text box is the entry fee for each player per 9-hole round.

Pay — This text box is where to put or pay the entry fee.

Admin Fee — This amount is the percentage of the money collected that is used as an administration fee.
Payout 1 — These are the first payout options.

Total Pot >= — This is the minimum amount of money collected to determine if payout 1 option is
used.

First — This amount is the percentage payout for first place.
Second - This amount is the percentage payout for second place.
Third — This amount is the percentage payout for third place.
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Payout 2 — These are the second payout options.

Total Pot < — This is the maximum amount of money collected to determine if payout 2 option is
used.

First — This amount is the percentage payout for first place.
Second - This amount is the percentage payout for second place.

4151 Reset New Season

To reset new season, click the Reset New Season button.

Reset New Season |
What do you want to do? ]

[ Bemove Inactive Players

[T Mew Season Cancel

[ The data was saved from the previous year.

| Ready ... |

Remove Inactive Players — Select this check box, to remove inactive players. Select one of the options
to the right of the check box.

x
What do you want to do? ) )
[® Bemove Inactive Players © <5 Rounds
P 1 < 4 Rounds
B¢ New Season ) < 3 Rounds
: 1 < 2 Rounds
) Mo Rounds

[X The data was saved from the previous year.

| Ready ... |

New Season — Select this check box, to clear the entire records from the previous year.
The data was saved from the previous year.  — Select this check box, to enable the Reset button.
» Click the Reset button, to reset.

4.1.6 Print Setup

To set the properties of the default printer, click File|Print Setup from the menu bar.

4.1.7 Exit

To exit the application, click File|Exit from the menu bar.
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4.2 Courses...

To execute the Courses Management application (COURSES.EXE), click Courses... from the menu bar.
See the Courses Management User Manual for instructions.

4.3 Members...

To execute the Members Management application (MEMBERS.EXE), click Members... from the menu
bar.

See the Members Management User Manual for instructions.

4.4 Non-Members...

To execute the Non-Members Management application (NONMEMS.EXE), click Non-Members... from
the menu bar.

See the Non-Members Management User Manual for instructions.
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4.5 Players...

Click Players... from the menu bar to open the Friday Stableford Players dialog, which allows users to:

» Add, edit and delete players to database.

e Print money earned list.

» Update Handicap Factors.

»  Print points needed table.

» Select option to use Handicaps from the Handicap System or last five rounds.

Friday Stableford Players |

Exit Add Edit Delete

1] [tame |Member [HF | ClubHop | Hep | Meed [ Added

b Lee. Kewin YES 111 12 12 12 2008/05/23 ;l
181 Lepage. John WES 225 24 ] 6 2004/05/07
202 Lewinski, Lome WES 18.0 20 a 8 200440507

91 Lorie, Tom WES 8.1 g 14 14 200871722
216 Machillan, Jim WES 1748 149 g 4 2004/09/03
2h3 MacRae, Mark YES 115 13 12 12 2007/05/04

battie, Francis e : 2004205/07
152 McCall, Verme ves 23ib 2B B 5 2004/05/07
271 MclLaren, Roh ves 107 N 13 13 2005/07/01
92 Mchahon, John ves 324 36 3 1 200811722
579 Meilleur, Lindsay ves 189 21 g §  2008/08/13
186 Meilleur. Sonny ves 110 12 1212 2004/05/07
258 Miller, Davvid ves 113 12 1213 2007/06/29
130 Miller, Flaoyd ves 241 2h ) 5 2004/05/07
171 Miller, Orval ves 111 12 1212 2004/05/07
419 hoon, Doug WES P 24 f B 2007/0518 -

Print Money List I

[ Uze Handicap

| Update Handicap Factors I Print Points Heeded T able I

Ready...

Use Handicap — Select this check box to have the application calculate points needed with Handicap
Factors from the Handicap System, otherwise use points made from the last five rounds.

451 Menu Items

Exit Add Edit Delete

4511 Exit

To exit the Friday Stableford Players dialog, click Exit from the menu bar.
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451.2 Add
The Add menu item offers commands to 2 dropdown menus:
Add
Mernber
Mon-Member

To add member to the Friday Stableford database:
1. Click Add|Member from the menu bar.
2. Select member from the Select Golfer dialog.
3. Click the Update button.
To add non-member to the Friday Stableford database:
1. Click Add|Non-Member from the menu bar.
2. Select non-member from the Select Golfer dialog.
3. Enter non-member’s current handicap factor.
4. Click the Update button.

45.1.3 Edit

To edit player from the Friday Stableford database:
1. Select the row containing the player to edit.
2. Click Edit from the menu bar.
3. Make the necessary changes.
4. Click the Update button.

4514 Delete

To delete player from the Friday Stableford database:
1. Select the row containing the player to delete.
2. Click Delete from the menu bar.
3. Click the Yes button on the Confirm... window.

45.2 Command Buttons

4521 Print Money List

Click the Print Money List button to print money earned by each player during the current season.

45.2.2 Update Handicap Factors

Click the Update Handicap Factors button to update the Friday Stableford database with Handicap
Factors from the Handicap System.

4523 Print Points Needed Table

Click the Print Points Needed Table button to print points needed table, including player’'s name, points
made in the last five rounds and points needed (See sample in Section 7.5).
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4.6 Signup...

Page 4-9

To access the Signup Players dialog, click Signup... from the menu bar (See Section 3.2.3 for

instructions).
=
add  Clear
Front Nine (White) Gross Score | 1 :
Hole 1 2 /3 4 5 6 7 8 9 Ou Points
Par 5 4 4 3 4 4 3 4 5 36 M| N |+
Back Nine (Yellow) Gross Score | 2 :
Hole 10 11 12 13 14 15 16 17 18 In Points
Par 5 4 4 3 4 4 3 4 5 36 M| N |+
Copy |
Scorer: -
S}'Stﬂn IﬁfImlager Add to Scorecard Cancel Print
Feady ...
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4.7

Scores...

To access the Scores dialog, click Scores... from the menu bar.

Friday Stableford Week #4 - Friday, June &, 2008

Page 4-10

Exit Edit Wiew Delete Team.., Caloulake  Sort by Team  Print  Export
Hale Mumber iz |la |7 & a | ow o[ 11213141516 [17 [18| 1n |[Tat
‘fardage 536293|433|[155(371 (1383|216 362(525{ 3280{ 491 | 354|361 [185|(310(423(147 (421|475 3167|6447
Par 0 1 0 00 =00 <00 0 {0 e =
Handicap 0 = = = e 28 |[12]16 (14 |[10)18( 4 |[ &
Mame 1023|456 |F |89 ([Tot|{1 234|567 [8|9|M Pts
Doug Barnard FIEBBIEIFIBl4|B[E[51 (0o oo (fa (1ot {aje]-2|Fg|~

Ran Boath 0 00 <0 <0 =200 L0 L= L= = 0 (L {0 (= 0 A 10 e Iy Vo
Sanny Meillsur 0 000 <0 0 0 00 0 (. 3 (L (= (== L L [

Bill Seddon (= ST O 2 O (=2 O 2 (K (= (=
Steve Henson Bl (E|4|l5 (63564611 (011 (o2t 1 a8[&8]0F3
Ed Mutterback. BlE 4|57 545650 fojof2fojoij1riT(1(e]sa]-22

John Scheuneman || 6| 4 |5 |45 (6|4 | B[6 (46 [ 12111 (01 jfol1af3a]-

Raw walker 105|646 6| s|[e(7|5 o1 of1ofojoloofz[5]|-3|8&
Steve Henson SlE|E|Sl46 364442 001020203 [10[&|+|B9
Ed Mutterback. i <0 0 =20 00 0 0= =0 00 L= {0 = = = 0 e

John Scheuneman || 6 |5 |6 |4 BB |35 (546 [ 11 (01 oozt /2af]39]-

Raw wallker Els|[s 56|64 |e(6|4af1 1|1 0ololojrof1|s[s|0]
“w'hitriey Cook FlEslelalesl6la 75201 (of2|1(0fojfol15[5]0F3

Jack Gray B4 77|76 56|54 oj2[of1r/ofojolti1{sle]-1]4
Marley Taylor BlE 7B IE6 4| F[a(5 {11 (ofolojofq1jfojlofajal]s

(-6
“w'hitriey Cook FIEFIENEB3 751 (01 (ofojfojfrfa2fol26[5]+|B9
Jack Gray FIE7Fe 7?7455 |01 [(ofojojojrjoj2(4]6]-2|5n
Muarley Taylor (=0 0= 0 0 0 a0 =0 - (e 1 {0 (= (=
(-3
George Burkon FlB B35 62|45 (401 (0210222107 ]|+2|F9
Jim Macmillan Pl El3lE |64 554701 fof2lojfojriti2{7la]l1|n
Yerne McCall FI5lEll2|lE(6|4|E[E(48 (0|1 (Of3|o(fof1 o1 (6|&E]D0
Gerald Tallon l4a(ela(elel4(c(74oz(1(zafof1[ofaof&[a]|3|q]|~+
|F|ead_l,l...

This dialog allows users to:

» Add, edit and view player and team scores.
» Edit team number.
e Substitute players on a team.

 Remove player from team.
» View player's combined scores (front nine and back nine) or team 9-hole scores.

* Find the player that signed up the team.
e Delete a team from the 9-hole competition.

» Sort scores based on team points or by team number.

*  Print a number of reports.
e Export scores to Handicap System.

4.7.1

Exit Edit

Menu Items

Wieww Find Delete Team...

Calculate  Sork by Team  Prink

Expark:
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4.7.1.1 Exit

To exit the Scores dialog, click Exit from the menu bar.

4.7.1.2 Edit

The Edit menu item offers commands to 2 dropdown menus:

Edit

Team Mumber, .,
Tear...

To edit a team’s number:
1. Click Edit|Team Number... from the menu bar.
2. Select team from the list and click the Edit button.
3. Enter the new number and click the OK button.
To edit team:
1. Click Edit|Team... from the menu bar.
2. Select team from the list and click the Edit button.

X
Back Mine Signup Mumber. | 26
Tatal Paints Meeded: | 39
MHeed

Flayer 1: | Mattie. Francis D | Fi
Plaper 2: | Chaput, Todd D | 11
Flayer 3: | Hartwig, Tim D | 11
Flayer 4: | Hewitt, Dave D | 10

| (1] I | Cancel I

To substitute player:
a. Click the button to the right of the player to be substituted.

b. Select substitution player from the player’s list and click the OK button.

To remove a player (4-man team to 3-man team):
a. Click the appropriate button to the left on the player.
3. After the modifications, click the OK button.

Page 4-11
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471.3 View

The View menu item offers commands to 4 dropdown menus:

[ view
v Show Scores
Hide Scores
Plaver Scores
Scorer...

To show scores after hiding the scores, click View|Show Scores from the menu bar.
To hide the scores that are currently shown, click View|Hide Scores from the menu bar.

To combine front nine with back nine rounds and view 18-hole rounds, click View|Players Scores from
the menu bar. When this has been completed, the scores can be exported to the Handicap System (See
Section 4.7.1.8).

To view who signed up the team:
1. Click View|Scorer... from the menu bar.
2. Select team from the list and click the Who button.

scorer x|

L ] "_n., Francis Mattie was the scarer for Team Mumber 11,
L

471.4 Delete Team...

To delete a team from a 9-hole round:
1. Click the Delete Team... button from menu bar.
2. Select team from the list and click the Delete button.
3. Click the Yes button from the Confirm... window.

4.7.1.5 Calculate

To calculate and sort the display by plus/minus points, click Calculate from the menu bar.

4.7.1.6 Sort by Team

To sort the display by team number, click Sort by Team from the menu bar.
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4717 Print

Prink

Scares
Payout
Payout Labels

To print scores, click Print|Scores from the menu bar (See sample in Section 7.3).
To print payout results, click Print|Payout from the menu bar (See sample in Section 7.2).
To print payout labels, click Print|Payout Labels from the menu bar (See sample in Section 7.4).

4.7.1.8 Export

To export score to the Handicap System:
1. Click View|Player Scores from the menu bar.
2. Click Export from the menu bar.

4.8 Zip and UnZip
Zip LUnZip
ko Archive fFram Archive. ..
ko LISE Drive. .. fFram USE Drive. ..
48.1 Zip Files

To zip files to c:\golfsoft\archive\friday.zip :
» Click Zip from the main menu and click to Archive .
To zip files to USB Drive:

* Insert USB Drive into USB port.
e Click Zip from the main menu and click to USB Drive .

4.8.2 Unzip Files

To extract files from c:\golfsoft\archive\friday.zip to c:\golfsoft\friday
» Click Unzip from the main menu and click from Archive .
To extract files from USB Drive to c:\golfsoft\friday

* Insert USB Drive into USB port.
* Click Unzip from the main menu and click from USB Drive .



GO]fSOft ™ Page 4-14
S Software

4.9 Help

The Help menu item offers commands to 3 dropdown menus:

| Help

G0 ko Galfsaft Saftware \Website

online Manual

about, ..
To go to the Golfsoft Software website, click Help|Go to Golfsoft Software Website  from the menu bar.
To go online and view the Friday Stableford User's Manual, click Help|Online Manual from the menu bar.

To learn more about Friday Stableford application, click Help|About... from the menu bar.
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5. COMMAND BUTTONS

You choose a command button to initiate an action, such as carrying out or cancelling a command.
Common command buttons are OK and Cancel. They are often located along the bottom or on the right
side of the dialog.

A command button, followed by an ellipsis (...) or a double greater-than sign (>>) opens another dialog
box.

Unavailable command buttons are dimmed. The currently selected button has a darker border than other
buttons. You can choose the currently selected button, simply by pressing the Enter key.

To choose a command button, click the command button. Or press the Tab key until the button you want
is selected, and then press the Enter key.

After you start a new event or open an old event, the screen will display several command buttons:

Event Signup Sheet Courses

Simply, click the appropriate command button.

51 Event

This command button opens the Old Event dialog, which allows users to edit changes to parameters that
were set during create new event procedure (See Section 4.1.1).

odevent X

MHame of Event: Friday Stableford Week #4 I 4

Mame of Club: |Deep River Golf Club [1972] Inc. X Active

Date: | Friday. June 6, 2008 3 B Members Only
Entry Fee

Fee: | $2.00 Total Collected:) $192.00

F'.a_|,|;| Brown Box

(1] 4 Cancel

Ready ..

5.2 Signup Sheet

This command button opens the Signup Sheet dialog, which allows users to set who can play in the
competition.

Signup Sheet |

@ :Members Dnly: |’ Gender

@ L ] C L D | &
EElt:!'lu.ﬂr;:lults | rw * w w
% Seniors
[ Juniors | oF. | Cancel
Ready ...

Members Only — This check box determines if non-members can play in the competition.
Status — Select one or multiple options.
Gender — Select one of three options.

» Click the OK button, to accept changes.
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5.3 Courses

This command button opens the Courses dialog, which allows users to modify the current course
information, such as: yardage, par or handicap. This dialog also allows users to select the tees of the
home course or select an away course and the tees.

x

‘Modify Course! Home Courze I
| Deep River Golf Club | 70123 | Away Course |

HoleMumber || 1 [ 2 [ 3 [ 4 |[ 5 ([ & | 7 (& || 9 || Out {7027 (12 13 |14 |15 ) 16 |17 |18 | In | Tat
Yardage [B36 (293 (433|155 (1371 (1389 || 216 | 362|525 || 3280 ||491 (354 ||361 |[(185 (310 |(423 |[147 |[421 | 475 || 3167 | 6447
Par |5 (4 (43[4 (a3 |4 |63k [5(4 (434|413 |4|5]| 36| 7
Handicap 1 (135 1709 || 7 15 (11 | 3 2 &8 (1216 |14 (10§18 [ 4 |[ &

(1] Cancel
|F|eau:|_l,l...

Home Course - Click this command button to select the tees of the home course.
Away Course - Click this command button to select an away course and the tees.

Modify Course - Click this command button to modify the details of the selected course, such as:
yardage, par, and Handicap stroke holes.

5.3.1 Modify Course

This command button opens the Modify Course dialog, which allows users to modify the course
information such as: yardage, par, and Handicap stroke holes.

When playing competitions, such as Stableford, the points are awarded based on par. Normally, golf
courses rate the holes based on average scores of the hole. Therefore, it makes sense that the
Handicap stroke hole should be based on par. This dialog allows these changes to be made. A
temporary tee may also be used for the competition. Hence, the yardage or par for the hole can be
modified. The new modifications will be displayed on the scorecards, screen displays and reports.

Front Nine

Hole Mumber || 1 |12 |3 [ 4 |5 | & || 7 |8 | 9 [Total
Vardage |536293)|433)]155)371)|383 216 || 362|525 [| 3280 | Cancel I
R ERERERREREREE

Handicap [ 1 | 7 3 9|5 4] 8|62

Back Nine

Hale Mumber || 10 (11 (12 [ 13 |[14 |15 || 16 17 | 18 [Tatal
Yardage || 491354 (361 {185 || 310)[423)147 (421 || 475 [ 3167
Par B4 a3 443453k
Handizap THaea|slaalfzi|as:3

Par for hole number 17

e Click the OK button, to accept changes.
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This command button opens the Home Courses Selection dialog, which allows the user to select the

tees of the home course.

=
&
i Courses
Rating/Slope R -,
18-Hale Front Back E bt e s
[9.9[121] [35.0/121] [34.9/121] ID#: | 1 i il i g 2
65.2 106 B22.c/106 0 32.6/106 Mame of Course: Govemnar:
_ _ _ | Deep River Golf Club RCGA
Holes™ | Province:
18 =49 | Ontario
HoleMumber || 1 |2 |3 |14 |5 |6 [ 7 L& (9 | Out J 1011 12 [13 |14 [ 15 (|16 (17 (18 || In | Tot
Yardage  ||536 (293|433 155 |37 (1389 |[216 || 262 (525 | 2280 (1491 (354|361 | 185 (310 (422 [1147 |[421 475 || 3167 | 6447
Par |5 4 |4 23 |4 (424 )3& 5|4 (4021443 a|8]| 3|72
Handicap T (135 (1709 (7 15|11 | 3 2 (8 (1216 (14 (1018 |4 |6
Yardage (491 (1231 ||361 (101 312 (314 |[147 || 287 (456 || 2700 (435 293|298 | 155 240|383 1113 |[362 | 405 || 2690|5390
Par |5 3 |4 3|4 (4345355440344 32| 4] 35|70
Handicap [ 1 (15 [ (7[5 5 (1317 ({2 | & [0 |36 (14 [q2e] 2 [ |
1 White/Yellow || 2 Red/Blue Esc Key
to Cancel
Ready ...
To select the tees, click the appropriate button displaying the color of the tees or type the number that is
the tees to

displayed on the button. For example: press the 2 key from the keyboard, if you want to set
Red/Blue.
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This command button opens the Away Courses Selection dialog, which allows the user to select away
courses and tees.

Away Course Selection...

)

=l
Ligt of Courses: | Bear Mountain Golf & Country Club j|

Rating/Slope
Front

18-Hale

Back

ID#: | 423

M ame of Course:

Courses

s T

|EB.-‘I|129| |34_2” 29| |34_2” 29| | Fear Mountain Golf & Country Club I-g)lefa g Bovernar
F'ru:uvmce:| BC RCGA
Hole Number [ 1 | 2 | 3 | & | 6 | 6 | 7 | & | [ 0w [10]11 12 [13 |14 15[ 16 17 |16 In | Ta
Vadage | 543375395 | 194 | 433 | 432|173 | 483 556 | 3650 | 364 152 429 468523 471 |189) 343 | 6503 | 3562 [ 7212
Pa |64 43 |%|&|3 4|63 |[43|4]|4|6|43|]|6]|m]|7e
Handicap |17 |15 13| @ |1 | 3 |11 6 | 7 1214 8 [[2 [0 6 |16 16 4
Vadage |523| 345|362 | 163 | 454 | 410155 443 537 | 3421 | 338|135 407 | 453509432 [177 | 311 561 | 3323 |E744
Pa |64 43 |%|&|3 4|63 |[43|4]|4|6|43|]|6]|m]|7e
Handicap |17 |15 13| 8 |1 | 3 [11]5 | 7 I: 1214 & | 2 |10 6 1618 4 I:
Vadage |508] 325 329|150 | 423 | 397 |[148 |41 521 | 3232 |[315 125|389 | 437 | 450 330 | 166 | 269 510 | 3104 [£336
Pa |64 43 |%|&|3 4|63 |[43|4]|4|6|43|]|6]|m]|7e
Handicap |17 |15 13| 9 |1 | 3 |16 | 7 I: 1214 [ 8 [[2 [0 6 |16 16 4 I:
Vardage | 420(325 329 85 | 369203 |[148 413 440 | 2835 |[315 115 389 345 454 335 |58 363] 453 | 3048 583
Pa |64 43 |%|&|3 4|63 |[43|4]|4|6|43|]|6]|m]|7e
Handicap |17 |15 13| 9 |1 | 3 |16 | 7 1214 [ 8 [[2 [0 6 |16 16 4
Vadage |533] 415|384 |376 | 414] 316 |[155 |34 [188 | 3165 |[215 | 90 |315] 345387 279 | 95 | 259] 449 |[2434 5539
Pa |64 43 |%|&|3 4|63 |[43|4]|4|6|43|]|6]|m]|7e
Handicap |17 |15 13 | 8 | 1 | 3 |11 5 | 7 || 12 14 8 | 2 |10 6 1515 4 MMM
1 Gold | 2 Blue 3 Black | 4 White 5 Red

Search hyll

E=zc Key
to Cancel

| Type the |0 number of the away course, then press the Enter key...

List of Courses — This combo box allows the user to select an away course from the COURSES
database. If the ID number of the course is known, the away course may be select with the Search by
button. Click the Search by button and enter the ID number in the appearing text box.

To select the tees, click the appropriate button displaying the color of the tees or type the number that is
displayed on the button.
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6. DISCLAIMER
6.1 IT IS ILLEGAL TO MAKE UNAUTHORIZED COPIES OF TH IS
SOFTWARE

This software is protected under federal copyright
copies of this software except to make a backup cop
this software for any other reason including for sa
Penalties include fines as high as $50,000 and jail

law. It is illegal to make or distribute
y for archive purposes only. Duplication of
le, loan, rental or gift is a federal crime.
terms up to five years.

6.2 Golfsoft Software Product Warranty

The enclosed software product and the user manuals
all rights. No part of this user manual or any kin
reproduced or translated in any form or medium with
Software.

Golfsoft Software warrants to the original consumer

in this product will be free from defects in materi
receipt). If any diskettes or CDs supplied as part
provided that the consumer purchaser returns the me
the instructions in the following paragraph, Golfso
diskettes or CDs free of charge. This warranty is
this product (dated purchase receipt should be reta

To obtain a replacement diskette or CD, please retu
Golfsoft Software at the address below, accompanied
purchase receipt, your name and return address.

6.3 Disclaimer Notice

The software, diskettes, CDs and documentation are
merchantability, no warranty of fithess for a parti
either expressed or implied regarding the software,
expressly provided in the preceding paragraph. Acc
to the use, results and performance of the software
event will Golfsoft Software be liable to any perso
special or indirect damages resulting from possessi
including without limitation, damage to property an
personal injury, even if Golfsoft Software has been
damages or loss.

Under this warranty the user agrees that the liabil
kind of legal claim (whether in contract, tort or o
suggested retail price for the use of this product.

The terms “RCGA”, “RCGA Handicap Factor”, “Handicap

(N)”, “RCGA Handicap System”, “SLOPE”", “Slope Syste

“RCGA Course Rating”, “RCGA Slope Rating”, “Course

trademarks and service marks. With the exception o
and service marks are the property of the United St
Royal Canadian Golf Association and the Canadian La

system. As owner of the term “RCGA” and a Licensee

service marks, the RCGA has the sole right within i
marks by others.

This software was certified by the RCGA and can onl
associations that issues and maintains RCGA Handica
Handicap System as described in the RCGA Handicap S

are copyrighted and Golfsoft Software reserves
d of the accompanying materials may be copied,
out the prior written consent of Golfsoft

purchaser that the diskettes or CDs furnished
als and workmanship (as evidence by your
of this product prove to be defective and
dia to Golfsoft Software in accordance with
ft Software will replace and defective
valid for 30 days following the purchase of
ined as proof of purchase).
rn the diskette or CD only, postage prepaid to
by a statement of the defect, a copy of your

provided “as is”. There is not warranty of
cular use and no other warranty of any kind,
diskettes, CDs or documentation, except as
ordingly, the user assumes the entire risk as
, diskettes, CDs and documentation. In no
n or organization for any consequential,
on, use or malfunction of this product,
d to the extent permitted by law, damages for
advised of the possibility of any such

ity of Golfsoft Software arising out of any
therwise) will not exceed the manufacturers

Factor”, “Factor”, “RCGA Handicap Factor
m”, “Slope Rating”, “Handicap Differential”,

Handicap” and “Home Course Handicap” are

f the term “RCGA”, some of these trademarks
ates Golf Association, which has given the
dies Golf Association permission to use the
of those well-established trademarks and
ts jurisdiction to authorize the use of those

y be used by golf clubs or authorized golf
p Factors in full accordance with the RCGA
ystem manual. Golfsoft Software will not in

any way be held accountable for the misuse of this

All elements of this software and user manuals are copyright 1999-2011, Golfsoft Software. All rights

software.

reserved. Box 841, 25 Huron Street, Deep River, Ontario KOJ 1PO.

Telephone: (613) 584-4652 or Cell: (613) 639-9408.
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7. PRINT SAMPLES
The print samples are not actual size.
7.1 Scorecard
Team Number: 28 Friday, June 6, 2008
D points for triple bogey, 0 for double bogey, 1 for bogey, 2 for par, 3 for birdie, 4 for eagle, 5 for double eagle
Front Nine (White) Gross Score / Points 38
Hole 1 2 3| 4 5| 6| 7| 8| 9| Gross Points
Par 54| 43|44 ]3| 4| 5] 36 M | N | #-
1 Francis Mattie / / // / / .
2 Tom Lornie / /,,,,x , / //.,x //,/ , 14
3 John Alessio /, // / / 11
4 Rick Rousselle 6
Total Points: Total:
7.2 Payout

Friday Stableford Week #11 Results
Friday, August 1, 2008
Total Pot:  $176.00

Team (10) Made Need +/- Players: 88
Ron Booth 5 3 +2 Teams: 24
Sonny Meilleur 16 10 +6 Administration Fee:  $1.00

Ken Tait 5 4 +1
Bill Seddon 5 5 0
Back Nine Yellow Total +9 First Place $88.00
Team (5) Made Need +/-
Jack Gray 10 5 +5
John Walden 8 9 -1
Morley Taylor 6 5 +1
Front Nine White Total +5 Second Place $52.00
Team (26) Made Need +/-
Mike Hogue 16 16 0
David Miller 14 11 +3
Rob McLaren 10 10 0
Charles Sims 14 13 +1
Back Nine Yellow Total +4 Third Place $35.00
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7.3 Scores
Friday Stableford Week #11 Team Scores Friday, August 1, 2008
Front Nine White Back Nine Yellow
Yardage 536 293 433 155 371 389 216 362 525 3280 491 354 361 185 310 423 147 421 475 3167 6447
Par 5 4 4 3 4 4 3 4 5 36 5 4 4 3 4 4 3 4 5 36 72
Team Player 12 3 4 5 6 7 8 9 Gross 1 2 3 4 5 6 7 8 9 M N Pts
10 Ron Booth 7 6 5 4 586 36 7 49 001110200 5 3 +2
Back Sonny Meilleur 5 4 3 3 5 5 35 5 38 223211212 16 10 +6
Nine  Ken Tait 6 5 5 5 6 6 3 6 7 49 1 1 1 0 0 0 2 0 0 5 4 #1
+9  Bill Sedden 5 6 6 4 6 6 4 5 7 49 2 00100110 5 5 0
5  Jack Gray 5 3 6 3 6 7 3 6 6 45 2 3 0 2 00 2 0 1 10 5 +5
Frant  John Walden 5 5 7 4 5 4 5 6 6 47 2 1 01 1 2 0 0 1 8 9 -
Nine  Morley Taylor 7 6 53 6 53 6 8 49 001 201 2 00 86 5  +1
+5
26 Mike Hogue 4 5 4 4 4 4 3 4 6 38 31 212 2 221 16 186 0
Back David Miller 4 4 4 4 4 6 3 5 6 40 3 2 2 1 2 0 2 1 1 14 11 +3
Nine  Rob McLaren 6 4 5 5 4 6 3 6 5 44 1 2 1 0 2 0 2 0 2 10 10 0
+4 Charles Sims 4 6 4 5 4 4 3 5 5 40 3 0 2 0 2 2 2 1 2 14 13  +1
6 Jack Gray 6 6 6 4 5 7 3 5 7 49 1 00 1 102 1 0 6 5  +1
Back John Walden 6 5 5 4 4 6 3 66 45 1 1 1 1 2 0 2 0 1 9 9 0
Nine  Morley Taylor 5 6 5 4 57 3 6 7 48 2 01 110200 7 5 +2
+3
17 Mike Hogue 4 5 5 4 4 5 4 45 40 3 1 1 1 2 1 1 2 2 14 16 -2
Front Rob McLaren 5 4 4 3 4 5 5 4 6 40 2 2 2 2 2 1 0 2 1 14 10 +4
Nine  David Miller 4 5 5 4 4 5 4 4 5 40 3 1 1 1 2 1 1 2 2 14 11 +3
+3 Charles Sims 6 5 4 3 4 5 5 5 6 43 1 1 2 2 2 1 0 1 1 11 13 -2
18  Don Morrison 6 4 5 4 4 4 4 4 5 40 1 2 1 1 2 2 1 2 2 14 12 +2
Front Paul Unrau 7 6 5 4 5 5 X457 48 001 1 1 1 0 10 5 5 0
NIne  Dave Morrison 6 4 6 4 6 6 4 6 6 48 1 2 0 1 0 0 1 0 1 & 6 0
+2
16  Mike Paguette 6 4 6 3 55 3 6 5 43 1 2 0 2 1 1 2 0 2 11 8 +3
Back Orval Miller 6 5 5 3 6 5 4 46 4 1 1 1 2 0 1 1 2 1 10 11 -1
NIne  Jerry Sims 6 4 5 3 4 5 4 5 6 42 1 2 1 2 2 1 1 1 1 12 12 0
+2
21 Rick Rousselle 5 6 5 3 6 6 36 7 47 2 0 1 2 00 2 00 7 6 +1
Back Eric Senohrabek 6 4 4 2 4 5 2 6 6 39 1 2 2 3 2 1301 15 12 +3
NIne  Francis Mattie 6 4 5 3 6 7 4 6 X6 47 1 2 1 2 0 0 1 00 7 9 -2
+1 Jeremy Stewart 5 5 5 4 5 5 356 43 2 1 1 1 1 1 2 11 11 12 -1
9  John Lepage 75 5 4 6 6 36 5 47 01 1 1 00 2 0 2 7 6 +1
Back Peter Morris 5 7 6 4 5 5 4 6 7 49 2 00 1 1 1 1 00 6 7 -1
Nine  Martin James 6 5 4 4 5 5 3 6 5 43 1 1 2 1 1 1 2 0 2 11 10 +1
+1
25  Colin Allan 5 56 455 26 7 45 2 10111300 9 4 45
Back Paul Fehrenbach 5 5 6 3 5 5 3 5 5 42 2 102 11 2 1 2 12 10 +2
Nine  Barrie Hallett 7 6 6 6 X58 6 5 7 5 000000010 1 8 -7
0  Geoff Kidson 7 46 4586 5 7 7 5 0220110000 4 4 0
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Second Place: $52.00
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Team (5) Made Need +-
Jack Gray 10 5 +5
John Walden 8 9 -1
Morley Taylor 6 5 +1
Front Nine White Total +5

7.4 Payout Labels

First Place: $88.00

Team (10) Made Need +/-

Ron Booth 5 3 +2

Sonny Meilleur 16 10 +6

Ken Tait 5 4 +1

Bill Seddon 5 5 0

Back Nine Yellow Total +9
Third Place: $35.00

Team (26) Made Need +/-

Mike Hogue 16 16 0

David Miller 14 11 +3

Rob McLaren 10 10 0

Charles Sims 14 13 +1

Back Nine Yellow Total +4
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Points Needed

Friday Stableford Week #18 Points Needed

Friday, September 19, 2008

Name N [1]2]3]|4]|5 Name N [1]2|3|4]|5 Name N [1]2|3|4]5
Alessio, John 10 [1wof11|11]10]|10 Glen, lan 8 |s|s|a|s|s McLaren, Rob 13 |1z|1z|13 |15 N
Alessio, Orio 6 |4|8|9|5]|5 Gray, Jack 4 |3[3|7|6]|3 Meilleur, Lindsay 8 |77
Allan, Colin 6 |5|5|5]|9]s Hallett, Barrie 8 |[7|9|a|7]|s Meilleur, Sonny 9 |7 |1w0]9|9 |1
Allan, Garry 5 |7|2]8|5]|7 Hartwig, Tim 13 |9 |15]12]|17|13 Miller, David 12 | 141311121
Ball, Fraser 10 [12]|14|8 |8 |10 Hegney, Jim 5 |5|4|5]|4]|5 Miller, Floyd 3 |2|2(2]|2]2
Barnard, Doug 6 |a|8|5|1]s Henson, Steve 9 |w0]6|w0]7 |12 Miller, Orval 10 |13|n|10|3 |13
Bell, Paul 13 |12 |13 1413|123 Hewitt, Dave 12 14| 9 [10]|14]14 Moon, Doug 5 |s|s5|8s|o]|s
Booth, Ron 5 |2|4|5|7]|s Hogue, Mike 16 |16| 18|17 |18 19 Morley, Dennis 8 |5|w0|6|10|6
Boucher, Francis 8 |2|m|11|9|e James, Martin 12 |11]13|16|12] 9 Morris, Peter 8 |6 |09 7|10
Briden, Neil 11 |13 (12]13|5 |12 Jay, Paul 15 |16 |14 |14 13|17 Morrison, Dave 8 |m|o]s|s |5
Buchanan, Stu 3 |42 Joynes, lan 10 |7 |7 Morrison, Don 11 |15|10|10|10|89
Buckley, Leo 6 7|7 |4|s6]|5 Kidson, Geoff 5 |s|5|8|1]|7 Murphy, Jim 9 |wof1|4]|a]i
Burton, George 10 |77 11|98 Knight, Chris 10 |11 |6 [10]10] 11 Mutterback, Ed 8 [3|8|13]5]|9
Carlin, Terry 4 (4|3 ]4]|3]|4 Kyle, Glen 10 |11]10] 8 |11|10 O'Ryan, Ralph 8 |1w0]5|10]5 |10
Chaput, Todd 12 |13(15]12| 5 |14 Ladouceur, Wayne | 5 |5|4|9|5]¢4 Olfert, Jeff 10 |[wof10|15|6 |10
Chisholm, Martin 14 |16 |14 ]12|13|14 Laporte, Dieter 13 |14 (12|14 )12 14 Paquette, Mike 9 |8|8|10]10|8
Christie, Bob 12 |12 (13 ]10]12|13 Leachman, Dave 11 |13 |11 |10]10(13 Potter, John 9 |6 |1|10|a|8
Connelly, Doug 6 |33 Lee, Kevin 10 |mof10]10]10]10 Potter, Melvin 5 |s|4|8|6|4
Cook, Whitney 5 |wo|s|5|0]4 Lepage, John 6 |7|s|7|3|5 Rodych, Ernie 3 |3|3|3|3|3
Cox, David 8 |06 |10]s6|10 Levinski, Lorne 7 |9|5|a|24]¢9 Ross, Don 7 lo|6|a|s]|7
Ethier, Dave 12 |12|10|18] 8 |13 MacMillan, Jim 9 |8 |7 |17 |10 Rousselle, Rick 5 |3|4|4]7 |5

Fehrenbach, Paul 11 |[11|12]14|10] 9 MacRae, Mark 10 |8 |12|10|11]|8 Ruhnke, Earl 6 |8|5|6|4]|9
Fleury, Bert 13 |12{14 13|12 )15 Mattie, Francis 10 |ni|11|e |7 |13 Scheuneman, John | 9 |8 |1]& 1|7
Gilks, George 11 |n i 1|n McCall, Verne 6 |s|5|8|5]|6 Seddon, Bill 6 [5(5|7|9]|6

Points Needed = Average of Last Five 9-Hole Points Made or (36 - Home Course Handicap) / 2 (round up)
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